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Order Entry Guidelines for Retail Direct Market Access Clients 
 
 
Background:  The Universal Market Integrity Rules 
 
The Universal Market Integrity Rules (UMIR) were created to provide a common set of equity 
trading rules for the marketplaces that are regulated by Market Regulation Services Inc., including 
the Toronto Stock Exchange and the TSX Venture Exchange. These rules exist outside the 
rulebooks of the individual exchanges and are primarily designed to regulate or prohibit various 
trading practices, including manipulative or deceptive methods of trading, short selling, front-
running, best execution obligations, order entry and order exposure, as well as trading halts, 
delays and suspensions.  
 
The UMIR were drafted to apply to the “Participating Organizations” (Exchange Members or 
Dealers) and “Access Persons” (subscribers to Alternative Trading Systems) and primarily govern 
the handling and trading of client and principal orders. Under UMIR and the rules of the various 
exchanges, Participating Organizations are considered “gatekeepers” and are entirely 
responsible for all orders and trades bearing their dealer number. This is true regardless of 
whether the orders were handled by the PO’s trade desk staff or entered directly by a client. 
Consequently it is important that Direct Market Access Clients be aware of the general provisions 
of UMIR relating to the entry of orders so that they may assist TD Waterhouse in meeting its 
regulatory obligations. 
 
 
General Order Entry Requirements:  Prohibition on Abusive Trading  
 
Section 2 of the Universal Market Integrity Rules deals with Abusive Trading. In particular, UMIR 
2.2 contains a general prohibition on manipulative and deceptive activities. The rules forbid the 
entry of orders or the execution of trades in situations where it is “known or ought reasonably to 
be known” that the orders or trades might create a false or misleading appearance of trading 
activity or interest in the security, an artificial ask price, bid price, or sale price. There are three 
main regulatory concerns addressed by UMIR 2.2: trades that create artificial volume because 
they do not represent a real change of beneficial ownership, trades that create artificial prices 
because they do not represent real demand, and orders that are entered without the intention of 
effecting a trade.  
 
As noted above, while the Participating Organization is ultimately responsible for compliance with 
the UMIR requirements, it is our expectation that clients who have been given Direct Market 
Access will respect these rules and policies. UMIR Policy 2.2 provides some examples of order 
and trading activity that by their very nature are considered manipulative and deceptive. 
Specifically: 
 

• Making a fictitious trade; 
• Entering a trade which involves no change in beneficial or economic ownership; 
• Effecting trades with the intent of limiting the supply of the security available for 

settlement of trades made by others; 
• Entering an order with the knowledge that an order or orders of substantially the 

same size, time, and price will be entered in the opposite direction; 
• Making purchases / bids at successively higher prices or sales / offers at 

successively lower prices; 
• Establishing a predetermined price or quotation; 
• Effecting a high or low closing price or quotation; 
• Maintaining the trading price, bid or offer within a pre-determined range; 
• Entering an order or a series of orders that are not intended to be executed; 
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• Establishing an artificial price i.e. one not justified by real supply & demand. 
 
A bid price, ask price or sale price for a security may be considered artificial depending on a 
variety of factors, including the price of preceding and succeeding trades, recent liquidity in the 
security, the time the order is entered, and whether the account for which the order or trade was 
entered has any motivation to establish an artificial price. For example, a 100 share buy order in a 
security for an account that owns a large quantity of that particular security that is entered very 
late in the day would be highly suspicious, particularly if the order betters the bid or results in a 
trade that raises the last sale price.  
 
Some additional examples of activities that will be considered suspect are: 
 

• Entering orders for the same account that have the potential to trade against each 
other (e.g. entering a market buy order for a security while having a sell order on the 
offering side of the market). 

• Entering orders, without the intention of trading, in an effort to induce others to trade 
(e.g. entering a large bid for a stock just below the current market price that causes 
others to believe that there is large buying interest in the stock). 

• Purchasing shares so as to be able to create a downtick for the purpose of making a 
short sale (Short sales on Canadian markets do not have to be on an “uptick”, merely 
the last sale price or better). 

• Entering orders that manipulate the Calculated Opening Price of a security in the pre-
opening and then canceling or altering them just before the opening. 

 
Generally speaking, if you conduct your activities professionally, avoid trading against your own 
orders and do not unduly influence the price of a stock you will not be considered to be engaging 
in manipulative and deceptive activities. The rules are not meant to inhibit legitimate trading 
activity, but rather to ensure that market participants are not creating an unfair market. Any Active 
Trader client who has questions about these or any other requirements of the UMIR should 
contact a customer service representative. 
 
In addition to the real time monitoring of trading by Market Regulation Services Inc., TD 
Waterhouse and its affiliates also conduct regular surveillance of all trading activity. Any client 
found to have engaged in any manipulative or deceptive trading activity will have access to ATP 
and other EBS systems revoked. The full text of the Universal Market Integrity Rules and the 
accompanying policies can be found at Regulation Services’ website. It is recommended that 
Active Trader clients read and understand the provisions relating to Abusive Trading before 
entering orders on their own. 
 
http://www.rs.ca/en/mktpol/umir01.asp?printVersion=no&loc1=mktPol&loc2=umir&loc3=01 
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1. Active Trader Plus Installation 
 
 
System Requirements Overview 
 
 
Before installing Active Trader Plus, be sure your system meets these minimum requirements:  
 

Computer Requirements Recommended Minimum 

Operating System Windows XP Windows XP 

CPU Pentium IV or higher Pentium III 1 GHz 

Memory 1 GB or higher 512 MB 

Video Card 32 MB or higher 32 MB 

 
Active Trader is designed to work with the following Internet connections: DSL, cable modem, or 
an alternate high bandwidth solution. 
 
 
NOTE: 
 
Attempting to operate Active Trader Plus on a PC which does not meet the minimum 
requirements above will result in system instability. Such symptoms as freezing, loss of Internet 
connectivity, increased lag times in the delivery of market data, and other negative consequences 
may be experienced.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 7

Installing from the Web 
 
 
You can easily install Active Trader Plus over your internet connection. To install Active Trader 
Plus over the internet, perform the following: 
 
4. Please visit www.tdwaterhouse.ca/activetrader and select the Active Trader Plus program 

under the Download Centre. 
 
5. When prompted, select “Save file to disk”, and select an easy-to-find location for the file (such 

as your desktop). 
  
6. After saving the file, double-click on ActiveTraderPlus.exe to launch the installer. 
 
7. Accept the license agreement, and follow the instructions to complete the installation. By 

default, the program will be installed in: “C:\Program Files\TD Waterhouse\Active Trader 
Plus”.  The location can be altered during the installation if desired. 

 
Once the install is complete, the Active Trader Plus shortcut icon will appear on your desktop, 
and in your Windows Start Menu. 
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Active Trader Plus Update Utility 
 
 
When a new version or update to Active Trader Plus is available, a notice will appear when you 
log into the system. If this occurs, you will need to run the Active Trader Plus Update utility to 
download the latest version of Active Trader Plus. 
 
Perform the following to update Active Trader Plus: 
 

1. If Active Trader Plus is currently running, close the application by selecting File > Quit 
from the main menu. WARNING: Active Trader Plus must be shut down to properly 
update to a new version. 

 
2. From the Windows task-bar (usually located at the bottom of your screen) select Start > 

Programs > Nexa > Update Active Trader Plus. A dialog box asking if you want to 
update Active Trader Plus to the latest version appears. 

 

 
 

3. From the confirmation dialog window, click Yes. The Update dialog appears indicating the 
download status of the update. 

 
 
NOTES:  

• This process can take a few minutes depending 
on the size of the update and the speed of your 
internet connection. 

• You can abort the update download process by 
clicking Cancel. 

  
 

4. The Update Completed dialog appears when the download is complete. Click OK to close 
this window.  

 

   
 
  

5. You can now start the new version of Active Trader Plus. 
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Starting Active Trader Plus and Logging In 
 
 
To start Active Trader Plus, perform the following: 
 

1. You can start Active Trader Plus from two locations, perform one of the following: 
 

• To start Active Trader Plus from the Windows Start menu, select Start > Programs > 
TD Waterhouse > Active Trader Plus 

• To start Active Trader Plus from the desktop, locate the Active Trader Plus shortcut 
and double-click it. 

 
 

2. The Active Trader Plus login window appears. 
 
3. In the Connect ID field, type your Connect ID. 

 
4. In the Password field, type your password. 

 
 
5. Click the Options button if you want to change the network or news server address, 

proxy server settings, language, or the look and feel scheme (skin). The Login window 
expands to display additional options.  
 
NOTES: 
• Type or select new options from the drop-

down lists, as necessary. 
 
• Accept the “Live” server address contained 

in the Connect drop-down window unless 
instructed otherwise. If a new address is 
required, click on the network button and 
type it into the field as instructed by 
technical support.  Select “Demo” if you 
wish to login.  

 
• Select the desired interface language from 

the Language drop-down. When you 
change the language option, you will need 
to restart Active Trader Plus. 

 
• Select the preferred colour scheme setting from the Skin drop-down field. When you 

change the Skin option, you will need to restart Active Trader Plus. 
 
• To stop the login process while it is attempting to communicate to the server, click 

[Cancel].  
 

• To close the login window and abandon the process altogether, click the [X] in the 
upper right corner of the box.  

 
6. Click OK to log into the system. Active Trader Plus will appear. 
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2. Menus, Tool bars, and Icons 
 
 
Basic Navigation in Active Trader Plus 
 
 
There are three main methods of navigation in Active Trader Plus: 
 

• Window Controls 
 
• Drag & Drop Functionality 
 
• Right-Click menus 

 
 
Window Controls: Each Active Trader Plus window (also referred to as a "module" or "box") 
uses standard window controls. These controls include the Minimize, Maximize/Restore, and Exit 
buttons located in the upper right-corner of each window. You can also resize each window by 
clicking and dragging on its edges or corners. The entire window can be moved by clicking and 
dragging on its title bar. 
 
Drag & Drop Functionality: Stock symbols may be “dragged and dropped” from one module to 
another throughout Active Trader Plus. For example, you can drag a symbol from a list in the 
Market View window and drop it onto the Stock Box to get a Level II quote for that symbol. You 
can also drag a symbol from the Open Positions tab in the Account Box into a Stock Box in 
order to trade on the position. In general a stock symbol can be dragged and dropped from any 
Active Trader Plus module to any other module which permits a stock symbol to be entered. 
 
Right-Click Capabilities: The right mouse button is used in every module to display a context-
sensitive menu of operations. Some of the right-click menus are brief, while others are complex. 
Right-click menus for each window change to reflect the options specific to the selected window 
(for example in the Open Orders screen versus the Open Positions screen within the Account 
Box). 
 
Modules that display lists of information (such as the Market View or Positions Tab in the 
Account Box, etc.) include the following standard right-click menu choices:  
 

• Columns: this will display a Columns dialog box allowing for each of 
the columns within the module to be toggled on or off, as well as the 
column order to be determined.  

• Print: prints the contents of the window 
• Export: exports the contents of the list module to a Comma 

Separated Value (CSV) file. This type of file can be opened directly 
with Microsoft Excel and other spreadsheet programs.  

• Smart Width: this option will resize the columns in the module so 
that each column width is equal to the maximum data width and all 
the values can be seen. 
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File Menu 
 
 
You can use the File menu, located at the top of Active Trader Plus, to perform some of following 
tasks: 
  

• Login: This option will display the Login window. You can use the Login window to log 
into additional accounts simultaneously. 

 
• Settings:  This option launches the Settings window. You can 

use the Settings window to customize the appearance of 
Active Trader Plus, as well as the default values for many 
settings. 

 
• Font: Select this option to choose the default font, font style 

and font size for Active Trader Plus. 
 

• Save Settings: This option saves the current settings for the 
current user. The saved settings include the size and location 
of all active modules, the stock symbols in each module, the 
setting values for all application variables, and additional 
settings. 

 
NOTE: Different settings files are kept for each Connect ID on a local PC. If a user is 
logged into multiple accounts, then the settings are saved under the first Connect ID (the 
account on the left-most tab in the Account Box). 

 
• Quit: Select this option to exit Active Trader Plus. If any settings have changed since 

they were last saved, then a Save Settings window asking whether you want to save the 
new settings appears. 
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Settings 
 
 
You can use the Settings window to change global settings for the overall appearance and 
operation of Active Trader Plus. 
 

 
 
 
When changing settings, click the OK or Apply button to save the current settings, or click 
Cancel to exit without saving the new settings. 
 
NOTE: Clicking the OK or Apply buttons can make changes to the current appearance of Active 
Trader Plus. Active Trader Plus may flicker momentarily when applying the new settings. 
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The setting categories contained in the Settings window are explained in detail in the following 
section: 
 

Colours section of the Settings window 
 

 
 
 
Colours: You can use this section to define the colour options for individual components of 
Active Trader Plus. To change a colour, click the colour next to the component you want to 
change. The Select Colour window appears. In the Select Colour window, select the Basic or 
Custom colour to use and then click the OK button. 
 

The colour settings are grouped in the following categories:  
 
• Default Colours: The basic background, text, and shading colours in all modules. 
 
• Market View: The background and text colours within the Market View and Index View 

modules. 
 

• Option in the Money: the colour used to highlight “in the money” option contracts within 
the Option Box window. 

 
• Stock Box: background colours in the Level I and Level II areas of the Stock Boxes, as 

well as the colours of each pricing tier in the Level II panel. 
 

• Time & Sales (T&S): the colour of each time and sales print determined by its relation to 
current Bid/Ask prices. 
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General Setup section of the Settings window  
 

 
 
 
General Setup is used to set the general functionality of Active Trader: 
 

• Auto Switch Account Box: When you are logged into multiple accounts and an order is 
placed, the Account Box will automatically switch to the corresponding account tab. 

 
• Auto Switch Order Account: When logged into multiple accounts, switching between 

account tabs in the Account box will automatically select the corresponding account in 
the drop-down fields of all active Stock and Option Boxes. 

 
• Display Net P/L:   When checked off net profit loss for positions closed during the day 

will be displayed in both the account header of the Account Box and will also appear 
under the Stats tab within the Account box. 

 
• Labels on navigation buttons: When this option is enabled, text labels are displayed 

below the buttons on the Quick Start tool bar and the module icons on the Navigator 
tool bar. 

 
• Set Symbol Upon Edit: When enabled this option allows you to double click on a 

security symbol within the Market or Index view to populate a stock, option or chart box.   
If not checked, double clicking on the symbol will allow you to only edit the symbol and 
you will have to double click on another field such as last price to perform the same 
action. 

 
• Symbols on navigation buttons: When this option is enabled it displays the relevant 

stock symbol below each of the Chart, Stock Box, and Option Box icons on the 
Navigator Tool Bar. 
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Highlighted ECN’s 
 
You can highlight a specific ECN so that it will be more visible in the Level 2 section of the each 
Stock Box. You can select as many as 6 ECN’s to highlight and choose the color in which to 
highlight them. 
 

 
 
 
 

Options section of the Setting window 
 

• Risk Free Interest Rate – Use this setting to change the interest rate used in the 
computation of the option price analytic Greek values.  Refer to the section on Option 
“Greeks” for additional information. 
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Hot Keys section of the Settings window 
 
 
 
Hot Keys - You can use the hot keys section of the Settings 
window to assign key combination for various tasks in Active 
Trader Plus. You can also use this section to enable and disable 
the Hot Keys feature. The following options are available from 
the Hot Keys section of the Settings window: 
 

• Enable Hot Keys: To prevent possibly costly order entry 
mistakes, the Hot Keys features are NOT enabled by 
default. To enable this feature click this box so that a 
check mark appears. 

 
• To create a Hot Key combination for a particular 

function, click on the value to the right of the function, 
and then press the Hot Key combination you want to 
use for the function. 

 
• To remove a Hot Key combination for a particular 

function, click on the value to the right of the function, 
and then press the Delete key to clear the field. 

 
NOTE:  The following Hot Key choices are NOT allowed – a 
single letter key, a single number key, or the [Delete] key.  
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Orders section of the Settings window 
 
Orders - Use this section to manage settings related to Order Entry and default order settings in 
Active Trader Plus:  

 
• Auto adjust order size: 

This field determines 
whether the system will 
automatically adjust order 
size when CLOSING a 
position.  If checked, an 
order to close a position 
which exceeds the share 
size of the open position will 
have its share size 
automatically changed to 
match the open shares 
available. If not checked 
such an order will be 
rejected as exceeding the 
available share size.  

 
• Auto Limit Buy Delta: Use 

this field to enter the dollar 
amount to use when setting 
the price of an Auto Delta 
Limit Buy.  This amount will 
be added to the current 
Best Ask to determine the 
Limit Buy price.  

 
• Auto Limit Sell Delta: Use 

this field to enter the dollar 
amount to use when setting 
the price of an Auto Delta 
Limit Sell.  This amount will 
be subtracted from the 
current Best Bid to 
determine the Limit Sell 
price.   

 
• Auto Limit Short Delta: 

Use this field to enter the 
dollar amount to use when setting the price of an Auto Delta Limit Short. This amount will be 
subtracted from the current Best Bid to determine the Limit Short price.  

 
• Confirm “Cancel All”:  When enabled, this option will display a confirmation window when 

canceling all open orders.  You must then confirm the order before it is sent to the servers for 
execution. 

 
• Confirm Cancel Order:  When enabled, this option will display a confirmation window when 

canceling an order.  You must then confirm the order before it is sent to the servers for 
execution. 
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• Confirm Equity Orders: When enabled, this option will display a pop-up window when 
placing equity orders. You must then confirm the order before it is sent to the servers for 
execution.  

 
• Confirm Option Orders: When enabled, this option will display a pop-up window when 

placing option orders. You must then confirm the order before it is sent to the servers for 
execution.  

 
• Default Debenture Contract Size:  Not Applicable 
 
• Default equity size: Use this field to set the default share size that will populate an order 

ticket for an equity symbol.  
 
• Default Listed ECN:  Use this field to set the default ECN which will appear within the order 

route field for all listed US equities.  ECN fees may be applicable when selecting an ECN as 
opposed to the default AUTO route setting. 

 
• Default Non Listed ECN: Use this field to set the default ECN for over the counter (Nasdaq, 

OTCBB) US equities.  ECN fees may be applicable when selecting an ECN as opposed to 
the default AUTO route setting. 

 
• Default option contract size: This field contains the default contract size that will populate 

an order ticket for an options contract.  
 
• Default Options ECN: Not Applicable 
 
• Default Order Type: This allows you to set the default order type within the Stock and Option 

Boxes.  The choices are Day, Good ‘Til Cancel, and Market order. 
 
• Display 24 hour time on orders: This option determines whether to display the time-stamp 

on order messages in 12 or 24 hour time format. The time-stamp messages are located in 
the Active Trader Plus log and the Order History window. 

 
• Display Cover/Buy-Close Button – Use this option to toggle on and off the cover/buy-close 

buttons used for placing an order to cover a Short equity position or buying to close a short 
option position.  This button is replaced by a cancel button on the order ticket when toggled 
off. 

 
• Display date on orders: This option determines whether to show the date stamp on order 

messages displayed in the Active Trader Plus log. 
 
• Enable Trade Type on Order:  Should always remain unchecked unless otherwise directed 

by the technical support team. 
 
• Fill MMID on Doubleclick:  This option allows the primary and sub order routes to be 

changed on the order entry ticket by double clicking within the level II book display for US 
orders.  WARNING:  Use of this feature can result in rejected orders as a result of orders 
being sent to routes not supported by the system.   This option should remain checked off to 
avoid rejected orders. 

 
• Fill size when dragging: Use this option to enable the population of the share size of an 

order ticket by dragging a position from the Positions window in the Account Box to a 
Stock Box. For example, if the default equity size is 100 and you have an open position for 
500 shares of CSCO, when you drag the CSCO symbol from their positions to a Stock Box 
(presumably to close the position), the share size will be changed to match the open number 
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of shares. If not selected, then the share size would remain at the default setting (100 in the 
example).  

 
• Save individual size: This option determines whether Active Trader Plus should remember 

the share size used for each specific symbol entered in an order ticket, regardless of which 
Stock Box is used. This “memory” persists as long as Active Trader Plus is running, but is 
erased when the application is shut down.  

 
• Save size always: This option determines whether the share size in the Stock Box stays the 

same when you change symbols. For example, when this option is enabled and Stock Box 1 
has a share size of 500 and Stock Box 2 is set to 1000 shares, these sizes will remain 
consistent no matter which symbol is entered.  
 
NOTE: The share size will still vary between Equities and Options even when Save Size 
Always is checked. The share size will be preserved within all like instruments (e.g. 200 for 
Equities and 10 for Options).  
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Quotes section of the Settings window 
 
Quotes – You can use this section to control global settings related to how market data is 
displayed in Active Trader Plus: 

 
• Change is from open: By default, 

the “Change” value displayed in 
Level I data (in the Market View, 
Stock Box, etc) is calculated vs. the 
previous close price. Click this 
setting so that a check mark 
appears to see the change 
calculated against this morning’s 
open price instead. 

 
• Display Quote Time: Enable this 

option to add the time of every 
quoted price into the Level II Quote 
display for all Stock Boxes. 

 
• Display T&S Time: Enable this 

option to display the timestamp on 
each print as it scrolls by in the 
Time & Sales area of each Stock 
Box. 

 
• Divide book size by 100: Enable 

this option to display the share size 
of Bid/Ask quotes and T&S prints 
divided by 100 for Book quotes 
(INET Book, etc.). For example, 
when enabled, 1000 shares will 
appear as 10 shares. 

 
• Divide equities size by 100: For quotes from exchanges, you can enable this option to 

display the share size of Bid/Ask quotes and T&S prints divided by 100. For example, when 
enabled, 1000 shares will appear as 10 shares. 

 
• Divide TSX/V securities based on board lot: Enable this option to display the share size of 

Bid/Ask quotes and T&S prints from the TSX and TSX/V divided as follows: (previous close 
under 10 cents = 1,000 shares, 10 to 99 cents = 500 shares, $1.00 and over = 100 shares) 

 
• Flash line on price change – Enable this setting to highlight price changes within the Market 

and Index modules.  The entire line containing the security will flash either green (increase) 
or red (decrease) in response to price changes. 

 
• Hide L2 non-local currency marks: Enable this setting to hide currency symbols (I.e. USD) 

when viewing a foreign-currency symbol in the Stock Box. 
 
• L1 non-local currency marks on Last only: Enable this setting so that the currency symbol 

currency symbol (I.e. USD) will ONLY be displayed on the “Last Price” when viewing a 
foreign-currency symbol in any Level 1 quote display (such as the Market View or the 
Account Box).  
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• Maximum decimal digits: Use this field to type the maximum number of decimal places to 
display on all price values in all modules.  

 
• Minimum decimal digits: Use this field to type the minimum number of decimal places to 

display on all price values in all modules (the default value for this field is 2).  The minimum 
number of decimal places will always be displayed, whereas decimal places above the 
minimum and up to the maximum are only displayed as necessary. 

 
• T&S from top: Instructs Active Trader Plus to show T&S prints from the top of the T&S 

window within each Stock Box.  This is the default settings.  Clear this checkbox if new T&S 
prints should appear from the bottom instead. 
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Stock Shortcuts section of the Settings window 
 

 
 
 
Stock Shortcuts – You can use this section to assign stock symbols to the ten Stock Shortcuts. 
You can then assign hot key combinations for each of the ten symbols. These serve as a quick 
method for pulling up quotes or charts for favorite stocks. Although the key combinations are 
defined in the Hot Keys section, the actual symbols that each combination represents are 
defined in the Stock Shortcuts section. Once these are set, and Hot Keys are enabled, the key 
combinations can be used in Charts and Stock Boxes to quickly call up preferred symbols.  
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Help Menu 
 
 

 
Selecting Help > About from the main Active Trader Plus toolbar will 
display the current software version of Active Trader Plus. Use this 
feature to determine your software version when asked by technical 
support.  
 

 
 
Version Number window 
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Navigator Tool Bar 
 
 
The Navigator tool bar contains buttons to access each active module in Active Trader Plus. 
 

 
 
There are two methods to view the Navigator Tool Bar. To display the Navigator Tool Bar, 
perform one of the following: 
 
• From the Active Trader Plus main menu, select Window > Navigator Tool Bar. 
 
• Right-click the Navigator Tool Bar and click Navigator. 
 
You can use the Settings window - General section to toggle the text labels on or off. Similarly, 
the stock symbols may be activated or deactivated below the icons representing the Option Box 
(chain link icon), Chart window (bar graph icon), and Stock Box (book icon). You can also hover 
the cursor over a button to display a description of its function. 
 
The entire Navigator tool bar may be positioned by clicking and dragging the far left edge, where 
the ridges are located.   
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Quick Start Tool Bar 
 
 
The Quick Start tool bar contains buttons to access active modules in Active Trader Plus. 
 

 
 
There are two methods to view the Quick Start Tool Bar. To display the Quick Start Tool Bar, 
perform one of the following: 
 
• From the Active Trader Plus main menu, select Window > Quick Start Tool Bar. 
 
• Right-click the Navigator Tool Bar and click Quick Start. 
 
You can use the Settings window - General section to toggle the text labels on or off. Similarly, 
the stock symbols may be activated or deactivated below the icons representing the Account 
box, Market View window, and Index View window. You can also hover the cursor over a button 
to display a description of its function. 
 
The entire Quick Start Tool Bar may be positioned by clicking and dragging the far left edge, 
where the ridges are located.   
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Window Menu 
 
 
The Window menu is used to control the presence or absence of Active Trader Plus modules and 
Tool Bars, as well as special layout management features. 
 

Modules – the top section of the menu lists individual Active 
Trader Plus modules, and allows the user to toggle them on and 
off. A check box to the left of a module indicates that it is active 
and visible within the application (although it may be hidden 
beneath other modules). Because there are multiple instances of 
the Option Box, Stock Box, and Chart modules, each of these 
objects has a sub-menu to the right that allows the specific 
numbered instance to be toggled on or off. 
 
Tool Bars – the middle section of the Window menu contains the 
two Active Trader Plus Tool Bars: Navigator and Quick Start. 
These choices toggle on and off these tool bars within the header 
area of the application. 
 
Layout Management – the four selections in the bottom section 
of the menu provide different types of layout control:  
 
• Tile: this selection will arrange all open modules by assigning 

each module roughly equal screen space. All modules will be 
visible but their size will not necessarily make sense relative 
to their function.  

 
• Cascade: this choice will take all open modules and arrange 

them one on top of the other, so that the title bar for each is 
visible. This layout does not make sense for usability, but it 
can be a useful starting point to see all of the open modules 
so that they can then be manually moved and arranged.  

 
• Smart Layout: using elements of both Tile and Cascade, 

with more intelligence, this feature arranges the open modules in a way that tries to increase 
their usability. The modules are each sized and placed according to use and importance. 
Additionally, if more Charts or Stock Boxes are active than can reasonably de displayed 
simultaneously, Active Trader Plus will Cascade the Charts and Stock Boxes within a 
specific area, while Tiling other modules.  

 
• Snap Grid: this feature toggles on and off, and helps the user line up the corners and edges 

of the various modules. When Snap Grid is active, and a module is resized, or dragged and 
dropped, it will snap into a position relative to the edges and corners of the surrounding 
windows.  
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3. Stock Boxes and Order Tickets 
 
 
Entering a Symbol 
 
 
There are four ways to enter a symbol into a Stock Box: 
 

• Type the symbol into the 
desired Stock Box and hit 
[ENTER]. 

 
• Drag and Drop a symbol 

from another module 
(Market View, Index View, 
Account Box, Symbol 
Lookup, etc.) into a Stock 
Box. 

 
• Use the Stock Shortcut 

keys within the Hot Keys 
functionality. 

 
• Double-click on a symbol in 

another module to populate 
the symbol into the last 
active Stock Box. 

 
 
 
 
 
 
 
 

 
Once a valid equity symbol is entered, the quote data will instantly appear, and Time & Sales 
“prints” will begin to appear as transactions for the stock are executed. Additionally, the title bar of 
the Stock Box will display the Stock Box number, followed by the market where the symbol 
trades, and the company name (e.g. “2:TSX:NORTEL NETWORKS CORPORATION” in the 
figure above).   
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Level I Data 
 
 
Level I quote area of a Stock Box 
 

The upper portion of the Stock 
Box contains basic Level I quote 
data. To the right of the Symbol 
field is the Tick Indicator. 
 
 
 

The nine values in the Level I section are statically positioned; they can neither be turned on or 
off, nor resorted. 
 
To re-size the columns: Right-click in this section and select “Smart Width” to automatically 
size the columns according to the data in each. Alternatively, hover over the indentations in the 
header bar just above the columns until the double-arrow pointer icon appears. Then click and 
drag the column border to the position desired. 
 
Explanation of data fields: 
 
• Close: previous day’s closing price – the last official print during market hours (post-market 

trading is not included). 
• Open: today’s opening price – the first official print at the open of market hours (pre-market 

trading is not included). 
• Chg: the change in price. By default this is calculated by comparing the “Last” price to the 

“Close”. However, the “Chg” calculation can be set to compare “Last” against the “Open” 
price in the Setup Utility.  

• High: the highest intraday price (extended hours trading is not included).  
• Low: the lowest intraday price (extended hours trading is not included).  
• Vol: the volume of share traded in this symbol (this does typically include extended hours 

trading). 
• Bid: the current Best Bid.  
• Ask: the current Best Ask. 
• Last: the most recent price to print in Time & Sales.  
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Level II Data 
 
 
Level I quote area of a Stock Box 
 
 
Unlike Level I quotes, which show only the single current transaction price, Level II quotes show 
all current parties (Market Makers and ECN’s for NASDAQ stocks, or the various exchanges for 
NYSE stocks) participating in the buying and selling of a stock, and the various price levels at 
which they are offering to buy or sell.  
 

 
 
The Bids are shown in the left column, and the Asks on the right. Each price level is indicated by 
a colour stripe within each column. The colours do not mean anything in an objective sense, but 
serve only to differentiate the price levels as the market moves. Colour preferences and decimal 
place settings can be set via the Setup Utility, under “Quotes”, as can the convention of dividing 
the share size by 100 or the applicable board lot size for Canadian equities. 
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The Basic Order Ticket 
 
 

 
  
 
Each Stock Box contains order functionality for equities via the Basic Order Ticket (BOT). This 
screen toggles on and off within each Stock Box via the far right button in the Stock Box header 
(as shown above). When active, the BOT displays just below the Stock Symbol field, and above 
the Level I section of the Stock Box.  
 
The settings and values within the BOT on the active stock box will impact all equity orders 
placed via that Stock Box, or via Hot Key combinations. The account number, share size, price, 
order type, stop price, etc., will all be used when an order is placed, even if the BOT is hidden in 
the case of an order placed via the Dome View or Hot Keys. To prevent costly errors, do not 
hide this module when placing orders.  
 

  
 
 
Each of the BOT fields is explained below (see the figure above for field reference numbers in 
red):  
 
1. Account Drop-Down: displays the active account number for this BOT. Any order entered 

from this Stock Box (or via Hot Keys while this Stock Box is active) will be placed against 
this account number. The contents of this drop-down includes all of the accounts to which the 
user is CURRENTLY logged-in. 

 
2. Buy Button: click here to send a Buy order using the parameters defined in the other BOT 

fields.  
 
3. Cancel Button: click here to send Cancel Requests for ALL open orders for the Symbol 

active in this Stock Box (e.g. in the figure above, clicking the Cancel button would send 
cancel requests for all open CSCO orders).  

 
4. Sell Button: click here to send a Sell order using the parameters defined in the other BOT 

fields.  
 
5. Short Button: click here to send a Short Sell order using the parameters defined in the other 

BOT fields.  Short sell equity orders are restricted to DAY orders only. 
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6. Share Size: enter the desired share size in this field. A default share size will first be 
displayed in this field depending on the settings contained in the “Orders” section on the 
Setup Utility.  Share size can be altered by: 

 
• Typing a specific quantity into the field. 
• Clicking the up and down arrows to the right of the field to adjust the quantity by 100 

share increments.  
• Using the [Up Arrow] and [Down Arrow] keys on the keyboard to adjust the quantity by 

100 share increments.  
• Holding the [Shift] key while using the [Up Arrow] and [Down Arrow] keys to adjust the 

quantity by increments of 10 shares. 
 
7. Limit Price: when a non-Market order type is selected from the Type/TIF drop-down (see 

number 8 below), the Limit Price field is available. By default this field will display the Best Bid 
price when the symbol is first entered, but the price will not update as the quote moves. Limit 
Price can be altered by: 

 
• Typing in an exact desired price.  
• Clicking on a price anywhere within the Level II quote display.  
• Clicking the up and down arrows to the right of the field to adjust the price in $0.01 

increments.  
• Using the [Up Arrow] and [Down Arrow] keys on the keyboard to adjust the price by 

$0.01 increments.  
• Holding the [Shift] key while using the [Up Arrow] and [Down Arrow] keys to adjust the 

price by increments of $0.10.  
 
8. Order Type/Time In Force: use this drop-down field to select the appropriate Order 

Type/Time-In-Force setting from the choices as follows:  (Please refer to ‘Market Restrictions’ 
for exchange times and order handling) 

 
• Market – asks the market to fill the order for all requested shares as quickly as possible 

at whatever the available market price may be.  
• GTEM – Good Through Extended Market - this limit order will remain in effect until the 

end of the extended market day, which includes after hours trading.  This order type is 
also used when entering a pre-market US order which will remain in effect for the entire 
trading day, including the after hours session.   

• GTC – Good ‘Til Cancel - this limit order will remain in effect until the user cancels the 
order for US orders or 90 calendar days for Canadian orders.  Orders automatically 
cancelled after 90 calendar days will display a status of ‘cancelled by force’.  GTC orders 
are not available for equity Short Sell Orders. 

• Day – Good For Day - this limit order will remain in effect until the end of the official 
market hours.  A ‘Day’ order placed at or after 8am is good until 4pm.  A special 
circumstance applies to TSX Day orders where if the limit price happens to match the 
TSX last sale price determined at 4:10pm EST, the order will automatically be placed in 
the TSX Last Trade session until 5pm EST unless cancelled prior to 4:15 PM EST. 

• IOC – Immediate or Cancel - this instruction indicates that time is more critical than share 
quantity. It asks the market to fill as much of the order as possible immediately, and then 
cancel any remaining shares.  This type of order is available only for US equities. 

• FOK – Fill or Kill – essentially an All or None order which must be executed immediately 
and completely or else the order is cancelled.  This order type is available only for US 
equities. 
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• S/Mkt/GTC – Stop Market (On Stop) - submits a Good Til’ Cancelled market order with a 
Stop Price (or Trigger price) such that the market order will remain virtualized on the 
Active Trader servers and will be activated or triggered only when the Stop price is 
reached (last trade is equal to or above the stop price for a on stop buy, equal to or below 
for a on stop sell).  The cancel replace function is not supported for this type of order. 

• S/Mkt/Day – Stop Market - The same as a S/MKT/GTC order except that the order will 
remain in effect until the end of the official market hours. 

• S/GTC – Stop Limit (On Stop) – submits a GTC limit order with a Stop Price (or Trigger 
Price) such that the order will remain virtualized on the Active Trader servers and be 
activated and sent to the execution venue only when the Stop Price is reached.  The limit 
price should be entered in the limit price field (field 7 in the figure above).  The stop price 
should be entered in field 9.  The modify order function is not supported for this type of 
order.  

• S/Day – Stop Market - The same as a S/GTC order except that the order will remain in 
effect until the end of the official market hours. 

• VTSO/GTC - Virtual Trailing Stop Order - submits a stop order in which the trigger or stop 
price moves in conjunction with the market price by the amount the user wishes to trail 
the market (“delta”).  The reasoning behind this type of order is that it allows you to set a 
limit on the maximum possible loss without setting a limit on the maximum possible gain, 
and without having to constantly readjust your trigger price.  The delta is entered in the 
stop price/delta field (field 9).  The order remains virtualized on the Active Trader servers 
until the order is triggered, at which time a market order is sent to the exchange.  The 
modify order function is not supported for this type of order.  
For example: If Stock XYZ is trading at $20 and a VTSO sell order is placed with a delta 
of $.50, the stop price will initially be $19.50 and will move up to maintain the delta each 
time the stock reaches a price higher than $20.00.  If XYZ moves down, the stop price 
will remain the same and a market order will be sent if the stock reaches the stop price.  
For a VTSO buy order for stock XYZ trading at $20.00 and a delta of $.50, the stop price 
will initially be set at $20.50 and essentially represents the maximum purchase price.   

• VTSO/DAY - Virtual Trailing Stop Order - The same as a VTSO/GTC order except that 
the order will remain in effect until the end of the official market hours. 

 
9. Stop Price/Delta: when any of the Stop Order types are selected this field is activated. Enter 

the Stop Trigger Price in this field for Stop Orders (the price at which when printed will trigger 
the Market or Limit order) or the Delta for VTSO orders (the amount the trigger price will trail 
the market price). 

 
10. Main Order Route (Execution Venue): by default this is set to “AUTO”, which instructs the 

Active Trader Plus servers to direct the order to the proper Execution Venue based on the 
settings contained in the order route table (as set by the brokerage).  The default “AUTO” 
settings are specific to the exchange and order type, but when a user wants to direct an order 
to a location other than the default, this drop-down is used. Available venues include: 

 
• ARCA – ArcaEx (the Archipelago Exchange) – accepts limit and market orders for Listed 

and NASDAQ securities. 
• INET – INET ATS (formerly known as Island) – provides varying degrees of liquidity in an 

electronic matching and display environment; allows NASDAQ and listed orders; does 
NOT accept market orders. 

 
11. Order Sub-Route (Preference): Not supported at this time.  The Fill MMID on Doubleclick   

option allows the primary and sub order routes to be changed on the order entry ticket by 
double clicking within the level II book display for US orders.  WARNING:  Use of this feature 
can result in rejected orders as a result of orders being sent to routes not supported by the 
system.   This option should remain checked off to avoid rejected orders. 
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Market Restrictions  

 
(Subject to Change) 
 
TSX/TSX Venture – Orders placed between 9:27 AM and 9:32 AM EST can be refused by the 
exchange to facilitate an orderly opening of the market as the calculated opening price (COP) is 
being determined.  Rejected orders during this time will have a status of ‘ECN rejected’ and can 
be re-entered until they are accepted by the exchange. 
 
TSX Last Trade Session (LSTS) – New orders entered after the regular market close intended 
for the TSX last trade session can be placed at 4:15 PM EST using GTEM and a limit price equal 
to the last trade price (as of 4:10 PM EST).  The last sale trading price is determined as of 4:10 
PM and the TSX only accepts cancel requests between 4:10 PM and 4:15 PM EST.   
 
TSX Venture – The TSX-V imposes an “offer +/- penny” fail-safe on market orders that sweep 
the current inside BID/ASK quantity and leaves a portion of the order open.  This fail-safe is 
added (on Buys – deducted on Sells) to protect both the client and market integrity.   
 
US Equity After Hours Trading - After hours trading (AHT) is available on Active Trader until 
5:30 PM EST. If you wish to participate in AHT between 5:30 PM and 7:00 PM EST you may do 
so by calling a representative at the Active Trader Desk, however you will be charged the full 
agent rate. 
 
GTEM – A GTEM order placed on or after 8 AM EST is good until 5:30 PM EST for US equity 
orders and 5:00 PM for Canadian orders (provided that the limit price matches the TSX Last 
Trading price).  Orders intended to participate in the US pre-market session can only be entered 
beginning at 8:00 AM and will be valid for the entire trading day including the after hours trading 
session until 5:30pm.     
 
GTC – GTC Orders on the TSX will be cancelled after 90 days.  GTC orders on the Montreal 
Exchange will be cancelled after 63 days.  The order will have a status of “cancelled by force”. 
 
DAY - A DAY order is good until 4:00 pm EST.  A special circumstance applies to TSX Day 
orders where if the limit price happens to match the TSX last sale price determined at 4:10 PM 
EST, the order will automatically be placed in the TSX Last Trade session until 5:00 PM EST.  
DAY Orders played after 5:00 pm EST will queue for the following day business day.   
 
MARKET – All MARKET orders sent after regular market hours (4:00 PM EST) using the AUTO 
route will be executed at 9:30 AM EST at the opening on the following trading day.  The primary 
route must be changed to ARCA if you wish to send a market order during the US extending 
trading session (pre-market and after hours). 
 
SHORT – Restricted to DAY orders only (equities).  Overbuying a short position will not make it a 
long position.  Only the specific quantity of shares that you are short should be entered as the 
system will not allow you to sell any additional shares bought in excess of your short position. 
 
VTSO – VTSO Orders can be triggered by erroneous trade prints (“bad ticks”) that are reported 
by the exchange.  These trades are not reflected in the high and low of the day.  A fill occurring in 
this situation would be valid and not disputable. 
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Bracket Order Ticket 
 
 

 
 
Depress the Bracket button to enable this feature will permit two buy orders or two sell orders to 
be placed simultaneously for the same position allowing you to “bracket” an existing position with 
a Limit order and an On-Stop order.  Both orders are virtualized on our servers and are not sent 
to the exchange until one of the orders is triggered, at which point the other order is cancelled.  
As an example: Stock XYZ is trading at $60. You can place a Limit sell order at $70 and a sell 
On-Stop order at $55. One of them will be triggered when the price of XYZ goes below $55 or 
above $70. The other order will then be cancelled. 
 
There are certain conditions a bracket order has to fulfill:  

• Minimum price is $3.00  
• Minimum price difference between the Limit price and the On-Stop price is 10% for security 

prices between $3.00 and $5.00, and 5% for security prices above $5.00  
• For an order to be triggered, at least 2 executed trades must be reported at the order price  
• In order to prevent triggering of an order upon a spurious trade report (“bad print”) the 

order will be triggered only if the order price is within a 10% range of the current Bid/Ask 
quote  
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The Advanced Order Ticket - Order Types and Functionalities 
 

 
 
Active Trader Plus offers advanced order capabilities designed to help sophisticated traders and 
money managers. The Advanced Order Ticket (AdOT) on each Stock Box allows for Scaled 
and Chained orders to be placed quickly and easily. 
 
WARNING – the Advanced Order Ticket features are designed for sophisticated traders, 
and are to be used with great caution. Inadvertent or uninformed use of these order types 
could result in very costly mistakes. 
 
The example below shows a Stock Box with the AdOT activated. Note that the Basic Order 
Ticket is always active with the Advanced Order Ticket as the data contained in the Share Size, 
Limit Price, Routing, and other fields are utilized by the advanced order types. The AdOT is 
activated via the toggle button with the exclamation point icon. As with the other similar buttons, 
each Stock Box is independent of the others.  
 
Stock Box with the Advanced Order Ticket active 
 

 
 
Each of the Advanced Order Types produces multiple orders for a single symbol, but each 
provides different quantity and pricing formulas designed for different circumstances: 
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Scaled Order features 
 

 
 
 
Scaled Orders: these orders are placed simultaneously with variations (scaling) in price and 
quantity. The Limit Price in the Basic Order Ticket is the starting price, while the “To” price on the 
Scaled Order tab defines the highest desired price point. The increment by which the price is 
augmented is set as the “By” price. In the figure above the pricing begins at $17.18, and scales to 
$17.22 by increments of .01 for a total of 5 orders. The order size begins with the Share Size set 
in the BOT, and scales up by the percentage set in the “Scale %” field. The share size need not 
be scaled and can be left at 0% if all orders at the incremented price points are to be the same 
size. The total number of shares that comprise the scaled orders is displayed in the “Total Size” 
field. Once the “Buy”, “Sell”, or “Short” button is clicked, all of the scaled orders will instantly be 
sent to the market with the Time-In-Force and Routing choices indicated in the BOT. 
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Chained Order features 
 

 
 
 
Chained Orders: A Chained orders execution is contingent upon the execution of another order. 
For example, using the previous image, when the first live order for MSFT executes, the system 
will then place Day order for 100 shares of CSCO at 17.20.  
 
WARNING: This type of advanced order is virtualized on the Active Trader servers and requires a 
valid symbol to be entered in the chain symbol field corresponding to an open order.  Attempting 
to send a chained order without entering a symbol in this field will prevent the order from being 
triggered and it will remain dormant on the platform without being sent to the exchange.  The 
advanced order ticket should be always be toggled off when not in use. 
 
Note: 
If you have multiple live order for a chained symbol (such as MSFT in the previous example), the 
first order for the symbol that executes will trigger the chained order.  
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The Book Box 
  
 

 
 
The Book Box is used to display depth of market within a specific ECN and is activated via the 
Window Menu > Stock Box > Book Box. It displays a Level II quote in two columns for the 
ECN selected in the drop-down to the right of the symbol field. However, the Book Box is a 
detailed representation of the order and price activity within the selected ECN only. 
 
NOTE:  
The best Bid and Ask from the INET Book will show up within the standard NASDAQ Level II 
quote with a Market Maker ID of “CINN” because all Island quotes for NASDAQ equities are 
routed through the Cincinnati Stock Exchange (as of Oct. 2002). 
 
The best Bid and Ask from the ARCA Book will show up within the standard NASDAQ Level II 
quote with a Market Maker ID of “ARCA”.  
 
The best Bid and Ask from the BRUT Book will show up within the standard NASDAQ Level II 
quote with a Market Maker ID of “BRUT”.  
 
To view the INET ARCA, or BRUT Book for a particular stock, the symbol can be typed directly 
into the Book Box module, or it can be dragged and dropped in, just as with the Stock Boxes.   
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The Dome View 
 
 
WARNING - the Dome View is an advanced quote AND Order Entry feature. It is used by 
sophisticated traders to quickly enter and manage live orders. Clicking anywhere within the Dome 
View screen will populate the order ticket with the selected price (the order must then be 
submitted from the order ticket) or CANCEL an existing order in one click. DO NOT use this 
feature until you are completely familiar with its operation. 
 

 
  
Both the Dome View and the Level II sections of the Stock Box can be toggled on and off 
independently within each Stock Box. As shown in the figure above, the two buttons near the 
center of the Stock Box header control these features. Depressing either button will toggle on the 
corresponding feature and clicking again will toggle it off. Each Stock Box can display or hide 
these sections independent of each other. 
 

  
 
 
When active, the Dome View presents price 
and share size data in a five-column display. 
Once the display is understood, the Dome 
View can be a very productive tool for 
sophisticated traders.  
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The columns within the Dome View convey information and provide functionality as follows: 
 
Center/Gray: the middle column displays the current quoted price levels, with the current best 
Bid and best Ask roughly in the vertical center. The last Time & Sales print is displayed in the 
center column by highlighting the price of the last print in the colour of the actual print, and 
inserting the share size. In the figure above, the last print of 2500 shares at $3.90 is indicated by 
the green box in the center of the middle column. Clicking on the middle column has no impact.  
 
First Right/Red: the red column to the immediate right of center displays the total combined 
share sizes (divided by 100) that are offered for sale (red = sell) at each price level. Since offers 
to sell are at or above the best Ask price, the red column stays in the upper right portion of the 
view. Clicking in this column will populate place a SELL order ticket at the price level clicked if 
open positions are held in this symbol, or a SHORT order if open positions are not held. 
 
First Left/Blue: the blue column to the immediate left of center displays the total combined share 
sizes (divided by 100) that are offered to buy (blue = buy) at each price level. Since offers to buy 
are at or below the best Bid price, the blue column stays in the lower left portion of the Dome 
View. Clicking in this column will populate a BUY order ticket at the price level clicked.  
 
 
Far Right/Red: the red column to 
the far right will display the total 
share size, by price, of open Sell 
(or Short) orders for this symbol 
(e.g. an order to sell 100 shares at 
19.73). Click on the order share 
size in this column to CANCEL ALL 
orders at that price. 
 
 
 
 
Far Left/Blue: the blue column to 
the far left will display the total 
share size, by price, of open Buy 
orders for this symbol (e.g. an 
order to buy 100 shares at 19.68). 
Click on the order share size in this 
column to CANCEL ALL orders at 
that price. 
 
 
  
 
  
To recap the functionality of the Dome View: 
 

• Click Center (Gray) Column – no action  
• Click First Right (Red) Column – populate a Sell or Short order at the price clicked in the 

Order Ticket.  
• Click First Left (Blue) Column –populate a Buy order at the price clicked in the Order 

Ticket.  
• Click Far Right (Red) Column – cancel all open orders at the price clicked.  
• Click Far Left (Blue) Column – cancel all open orders at the price clicked.  
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Time and Sales Prints 
 
 
Every completed transaction for the selected equity symbol will appear in the “Time&Sales” 
window to the right of the Level II “Ask” column. In order for the prints to convey useful 
information they are colour-coded at the instant of the print as it relates to the Bid and Ask prices 
at that moment. The colour used for each type of print is described below, and can be customized 
via the Colours section in the Setup Utility. The default print colours denote the following: 
 

 
• Green – transaction price is at the Ask.  
• Red – transaction price is at the Bid.  
• White – transaction price between the Bid and Ask.  
• Purple – transaction price is below Bid.  
• Gold – transaction price above Ask.  
• Teal (Cyan) – the transaction print occurs in a “Crossed” 

or “Locked” market. A “Crossed” market indicates that the 
best Bid price is greater than the best Ask price, while 
“Locked” denotes that the best Bid and Ask prices are the 
same.  

• Royal Blue – the relationship between the transaction 
price and the Bid/Ask levels is unknown.  

 
It is important to note that the colour of the print is relative to the 
Bid and Ask price levels, which are changing constantly. 
Therefore, multiple prints of the same colour can easily be at 
different prices. If all the prints are red and/or purple, chances are 
the price of the prints is gradually decreasing. Conversely, if all the 
prints are green and/or yellow, the price is probably increasing. If 
the colours are equally mixed, the prices are probably not moving 
very much as buy and sell pressure are roughly the same. 
 
 
 
 

 
The Up/Down Tick Indicator in the Level I quote display changes in accordance with the Level II 
quotes and the rules of determining uptick and downtick vary with each market. 
 

• For the NYSE and AMEX, an uptick is determined by the last transaction print. If the last 
print is at or above the best ask, then the stock is in an uptick. If the last print is at or 
below the best bid then, the stock is in a downtick. Any print in between the best ask and 
best bid will leave the stock tick unchanged. 

 
• For NASDAQ securities, an uptick is created when the best bid is increased. A down 

trend is present when the best bid is lower than the last best bid.  
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4. The Option Box 
 
Option Box Basics 
 
 
The Active Trader Plus Option Box presents detailed real-time option chains in an easy-to-use 
format. Two Option Box modules may be active simultaneously, and a new instance of the 
Option Box is opened via the Window Menu > Option Box selection, or via the New Option 
Box button on the Quick Start Tool Bar.  
 

 
 
As seen in the figure above, the Option Box consists of a header area with Level I quote 
information, an order ticket that toggles on and off, and a detailed option chain and quote 
montage area below the header.  
 
The Option Box Header contains two symbol fields in the upper left corner – one for the 
underlying and one for the specific contract. By entering the underlying symbol in the first field 
(“CSCO” in the figure above); the corresponding option chain will be displayed in the tabbed area 
below, with Call contracts on the first tab and Put contracts on the second. The Bid, Ask, and Last 
price for the underlying equity are also displayed to the right of the top symbol field.  
 
Click on one of the Calls or Puts in order to load the contract symbol in the second field 
(“VYCAW” in the figure above) and activate the corresponding quote feed. This will populate the 
Bid, Ask and Last prices for the contract in the Level I area to the right of the contract symbol, 
and will make the depth of book data visible in the Montage on the third tab.  
 
To place an options order, or use the montage feature, a specific contract (Call or Put) MUST be 
selected and visible in the second symbol field.  
 
The Contract Month drop-down is visible in the top right corner of the Option Box. This field 
allows a specific month to be selected, beginning with the current month, for which the option 
chain will be displayed. Or choose “ALL” from the drop-down to display all Option Chain data for 
all available months, organized into monthly folders.   
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Option “Greeks” 
 
 
The option chain area of the option box contains columns displaying the option price analytic 
Greek values.   
 

 
 
These values are defined as follows: 
 
Column Name Example Description 

• Delta .657 Delta is a measure of the sensitivity the calculated option 
value has to small changes in the underlying equity price. 
 

• Gamma .012 Gamma is a measure of the calculated delta's sensitivity 
to small changes in share price. 
 

• Vega .479 The amount that the price of an option changes 
compared to a 1% change in volatility. 
 

• Theta -.279 Theta measures the calculated option value’s sensitivity to 
small changes in time till maturity. 
 

• Rho .206 Rho measures the sensitivity of an option or options 
portfolio to a change in interest rate. 
 

• I-Vol 23.42 Implied Volatility in percentage. 
 

 
These values are computed based on the Black-Scholes Price Model (1973). 
 
The following assumptions are taken into account when computing them: 

• The stock pays no dividends during the option’s life  
• European exercise terms are used  
• Markets are efficient  
• No commissions are charged  
• Interest rates remain constant and known  
• Returns are lognormally distributed  
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The Option Montage 
 
 
The Montage presents depth-of-book data for the selected option contract. This consists of the 
best Bid and Ask currently quoted on each of the different exchanges, presented in a Level II 
style format, along with the Time and Sales prints as they occur.  
 

 
 
NOTE:  The Montage window will be blank unless a specific contract (Call or Put) is selected and 
visible in the second symbol field. 
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Using the Option Order Ticket 
 
 
The Option Order Ticket is activated and deactivated via the button to the right of the Contract 
Month drop-down in the upper right corner. The figure below shows the upper portion of the 
Option Box with the Order Ticket displayed.  
 

  
 
This Order Ticket functions identically to the Stock Box order ticket with a few exceptions: 
 

• GTC – Canadian GTC option orders placed on the Montreal Exchange will be cancelled 
after 63 days.  The order will have a status of “cancelled by force”. 

• The “Covered” checkbox – this instructs the Active Trader Plus system whether to 
open an options position as a covered or uncovered (“naked”) position. A covered option 
trade requires that a position of the underlying equity, with sufficient shares, be present in 
the account in order for the trade to proceed. Clearing this checkbox allows an option 
trade to proceed without the covering position. Note: you must be approved in order to 
trade uncovered contracts.  

• The Quantity field – although identical in appearance, this field represents a number of 
contracts, NOT shares. 

• Sell Open button – options contracts are not Shorted, they are Sold to Open, as 
reflected by this button. 

• On Stop Orders (S/MKT/GTC, S/MKT/DAY, S/GTC, S/DAY) – On Stop Orders are not 
available for Options.   
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Advanced Orders - Chained 
 
A Chained order execution is contingent upon the execution of another order. For example, you 
can use this feature to automatically write a covered call contingent upon the execution of an 
order for the underlying security.  In the example below, when an order to buy 1000 CSCO 
executes, place an order to Sell Open 10 contracts (covered) of CYQAD at $0.15.   

WARNING: This type of advanced order is virtualized on the Active Trader servers and requires a 
valid symbol to be entered in the chain symbol field corresponding to an open order.  Attempting 
to send a chained order without entering a symbol in this field will prevent the order from being 
triggered and it will remain on the platform without being sent to the exchange.  The advanced 
order ticket should be always be toggled off when not in use. 
 
Note: If you have multiple live orders for a chained symbol (such as CSCO in this example), the 
first order for the symbol that executes will trigger the chained order. 
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5. The Account Box 
 
 
Account Box Overview 
 
 
The Active Trader Plus Account Box is divided into three sub-sections: 
 

• Open Order Window 
• Messages Window 
• Account Activity Window 

 
When a user is logged into multiple accounts, a new tabbed instance of the Account Box is 
created for each account. Each account-specific tab within the Account Box includes an Open 
Orders Window and Account Activity Window. The Message Window is independent of the 
account, and contains all messages received by the Active Trader Plus terminal during the 
current session.  
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Account Activity - Open Positions 
 
 
The Open Tab shows all open positions – regardless of when they were opened. These positions 
are currently held in the selected account and their values are fluctuating in real-time as the 
market prices move. All of the positions on this tab contribute to the Open P&L calculation shown 
in the Account Box Header.  
 
As positions are closed (i.e. sold or covered) they will automatically fall off of this screen and 
appear on the Closed Position tab.  
 

 
 
Each column shows the following:  
 

• Symbol: the stock/option symbol. 
• Size: the number of shares/contracts owned. 
• Price: the price per share at which the position was opened. 
• PL/Share: the present profit or loss calculated per individual share.  Updated in near 

real-time on a tick-by-tick basis. 
• PL: the overall profit or loss for the total position.  Updated in near real-time on a tick-by-

tick basis. 
• PL (Daily): the daily profit and loss calculated by subtracting the open price from the 

current price and multiplying by the total quantity.       
• Time: the time at which the position was opened. 
• ECN: the execution system that filled the order opening the position. 
• Open ID: the identification number of the position-opening order. 

 
The Open Tab P&L does NOT take into account commission charges from the opening of the 
positions. The P&L calculation is derived purely from the stock price and may therefore 
understate a loss or overstate a profit by the amounts of the commissions incurred. 
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Account Activity - Closed Positions 
 
 
The Closed tab displays positions that have been closed during the current trading day. The 
positions detailed on this tab make up the Closed P&L calculations in the Account Header 
section. The columns contained in this section include:  
 

• Symbol: the stock/option symbol.  
• Size: the number of shares transacted.  
• Bought: the price per share when the shares were purchased.  
• Sold: the price per share when the shares were sold.  
• PL/Share: the profit or loss calculated per individual share.  
• PL: the overall profit or loss for the total position.  
• Time: the time at which the position was opened.  
• ECN: the execution system that filled the order opening the position.  
• Open ID: the identification number of the position-opening order.  
• Closed ID: the identification number of the position-closing order.  

 
 

 
 
Closed tab in the Account Activity window 
 
Right-clicking in the Closed tab will produce a pop-up menu with the standard 
Columns/Export/Print/Smart Width features. No additional operations can be performed on a 
closed position.   
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Account History - Order History 
 
 
The Order History Tab (see figure below) presents a record of all orders sent to the markets 
during the current day, regardless of whether they were eventually filled, rejected, or cancelled. 
 

• Id: the identification number assigned to the order.  
• Time: the time the order was entered (not the time of execution or cancellation).  
• Action: the type of order (Buy, Sell, or Short)  
• Symbol: states the name of the equity.  
• Size: is the number of shares in the order.  
• Price: the order price for Limit Orders, or “Market” for Market Orders.  
• Status: the current status of the order (Pending, Cancelled, Executed, etc).  
• Reason: an explanation of the Status, if necessary (for orders labeled as Rejected or 

Canceled).  
• ECN: the execution venue to which the order was sent.  

 

 
 
Order History tab in the Account Activity window 
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Interacting with Open Orders 
 
 
Open orders are displayed in a tabular format. The columns present the order details as follows:  
 

• Symbol: the stock/option symbol.  
• Action: the type of transaction (Buy, Sell, Short).  
• Price: the price-per-share for a Limit order, or “Market” for a Market order.  
• Size: the number of shares in the original order  
• Status: the current condition of the order (Accepted, Cancel Sent, etc)  
• Reason: explanation of the status under certain conditions.  
• Id: the numeric ID of the order. It is important to reference this number whenever 

contacting the Active Trader Desk regarding a specific order.  
• ECN: the execution network where the order has been sent. This is determined by the 

type of order (Market or Limit), the specific security (NASDAQ vs. NYSE, for instance), 
and other factors such as price or liquidity.  

• Type: Time In Force information if applicable.  
• Stop: the Stop Trigger Price when applicable.  

 
  
 
The right-click menu available in the Open Orders Window presents the following Options: 

 
• Cancel: to cancel an order, right-click on the specific order and choose 

Cancel. 
 
• Cancel All: will send a Cancel Request for ALL open orders (same 

function as the “Cancel All” button). 
 
• Modify Order: Click to modify a live order. 
 
• Columns: will launch the column layout utility – allows the user to hide 

or show particular columns and change column order. 
 
• Print: sends the contents of the window to the printer. 
 

• Export: exports the contents of the window to a CSV file – pops a “Save As…” dialog box. 
 
• Smart Width: adjusts the widths of the columns to display all values. 
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Message window Overview 
 
 
The Message Window displays important messages primarily regarding system status and order 
activity. Messages are presented in a colour-coded format to assist in quick identification of 
important content.  
 

• Opening LONG positions are confirmed by green-letter messages.  
• Opening of SHORT positions are confirmed by red-letter messages.  
• Closing of profitable positions are confirmed by green-letter messages.  
• Closing of money-losing positions are confirmed by red-letter messages.  
• System problems are indicated by red-highlighted message lines.  
• Resolutions of system problems are indicated by green-highlighted message lines.  
• Basic order flow confirmations are shown in white-letter messages.  

 

 
 
Message window with order and position activity 
 
All messages are maintained throughout the login session, and the Message Window scrolls so 
that earlier messages can be reviewed.  
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Multi-Account Management 
 
 
Active Trader Plus allows a user to be logged-in to multiple accounts simultaneously.   
 
If you have multiple TD Waterhouse Active Trader accounts, the account that was last used will 
be preserved upon exiting the application and reentering it. 
 
The settings file is saved under the first account’s Connect ID. In order to maintain a consistent 
set of layout parameters and application settings, login first using the same primary account every 
time, and then login to additional accounts as necessary and in any order desired.  
 
To login to additional accounts, use the File Menu > Login option or right-click in the Account 
Box header area and select Login from the pop-up menu (see figure below). In order to minimize 
performance impacts, it is best to avoid logging into more accounts than can be effectively 
managed simultaneously, and to logout of accounts as they are no longer needed.   
 

 
Right-click in the Account Box header area to display the Login 
shortcut menu.  
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Open Order Window Overview 
 
 
Immediately below the account number tabs is the Open Orders Window. Included in the sub-
section of the Account Box is the “Cancel All” button, the Account Header, and the Orders 
Screen.  
 

 
 
The “Cancel All” button is used to send cancel request messages for ALL open orders displayed 
in the selected account. When clicked, each open order will generate a cancel request, and the 
status will change to “Canceling”. Once a “UR-Out” is received from the execution venue the 
order status will change to “Canceled” and the order will fall off of the Open Order screen. 
Alternatively, some orders may be “too late to cancel” in which case the Cancel request will be 
rejected and an execution will be returned instead. 
 
To the right of the “Cancel All” button is the Account Header, which displays the Buy Power or 
Margin Excess and P&L information for the selected account (as shown in the previous figure): 
 

Understanding Margin Excess and Buy Power 
 
• Buy Power (BP): Cash and Registered accounts display Buy Power which represents 

the cash available for purchases.  The Buy Power figure displayed will update in real-time 
by deducting cash for open buy orders and crediting cash for filled sell orders.  Cash and 
Registered accounts are always cash up front on the Active Trader Platform, meaning 
that the system will only allow you to utilize the cash currently in the account and will not 
recognize money market as buying power.  Please contact the Active Trader Desk if you 
wish to have your buying power adjusted for the day to reflect a money market position in 
your account. 

 
• Margin Excess (ME): Margin accounts display Margin Excess which represents the total 

amount of extra capital available if you wish to use it.  It is the sum of the loan values 
generated for all securities, less any amounts already borrowed, plus any available credit 
balances.  Please note that inter-listed stocks use the Canadian closing prices for margin.    
Note: ME and BP will not reflect intraday deposits and withdrawals made on WebBroker 
until the following business day.  Please contact the Active Trader Desk if you wish to 
have your buy power or margin excess adjusted for the trading day to reflect any intraday 
transfers of cash or securities.   
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Profit and Loss (P&L) 
 

• Open P&L (O/PL): represents the total profit or loss of the positions presently held in the 
account. If the number is in green, then the total open positions are worth more than their 
opening price. If red, then the open positions are worth less than their opening value. The 
Open P&L changes just as quickly as the values of the open positions change with the 
market conditions. The Open P&L does NOT take into account commission charges from 
the opening of the positions. The P&L calculation is derived purely from the stock price 
and may therefore understate a loss or overstate a profit by the amounts of the 
commissions incurred.  

 
• Closed P&L (C/PL): indicates the total Profit or Loss realized from the closing of 

positions during the current day. If the number is displayed in green then the account has 
a profit from the closing of the positions. If red, then the account has incurred a loss on 
the closing of positions today.   

 
NOTE: The Closed P&L does NOT take into account past commission charges from the opening 
of the positions, nor the commission costs associated with closing the positions. The P&L 
calculation is derived purely from the stock price and may therefore understate a loss or overstate 
a profit by the amounts of the commissions incurred.   
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Setting Alerts on Open Positions 
 
 
The right-click menu within the Open Positions tab presents Alert Options in addition to the 
standard Columns/Print/Export features. Open Position Alerts are set based on P&L per share, 
and will alert the user when a particular position has exceeded a P&L/share limit (either above or 
below a threshold).  
 
To set a Position Alert: right-click on the position and 
select “Alert” from the menu. In the Alert Setup box, 
select whether to be alerted when the P&L drops below 
a certain value (PL/Share <=), or when the P&L 
exceeds a certain value (PL/Share >=), or both. Enter 
the value for the Alert Items checked as a dollar amount 
with decimal places (enter a negative number to be 
alerted for negative P&L values).  
 
 
 
Once the alert is set, the red arrow icon will appear next to the Symbol. The alert is saved as part 
of the user settings and will remain in effect until the user deletes it, or until the position is closed.  
 
When the alert is triggered, three indications are given – 
a sound is played, a pop-up is displayed, and a red 
flashing highlight appears in the Open Positions tab. 
After the alert is triggered, use the “Reset Alert” option on 
the right-click menu to remove the red highlighting on the 
symbol and to prepare the alert to fire again when the 
parameters are next exceeded. 
 
 

 
 
Flashing red highlight indicates that 
the position triggered its alert. 
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System Status Lights 
 
 
Active Trader Plus provides the user with constant real-time system status via the three “lights” at 
the bottom of the Account Box module. The colour of each box reveals the current condition of 
the connections to the system servers, and the status of the systems. All three boxes can display 
Green, Yellow, or Red status indications. Green indicates solid performance, and that all systems 
are operational. A Yellow indicator means that performance might be poorer than usual, or that 
some systems might be non-operational. Red boxes mean that a critical system component is not 
functioning.  
 

 
 
Additionally, hovering the mouse pointer over each status light activates a pop-up text box that 
provides more detailed status information. 
 
• Network: indicates the state of the Internet connection to the system servers. This light turns 

yellow when data delays exceed 500ms, and red when connectivity is lost. Hovering over this 
box provides statistics on both data delay (measured in milliseconds) and bandwidth 
(measured in bits per second).  

 
• Quotes: denotes the status of the Active Trader Plus quote data providers. Yellow indicates 

that one or more data stream is not available, and red corresponds with a loss of all quote 
data. Hovering over this box will produce a list of data providers with an “Up” or “Down” status 
for each.  

 
• Trading: similar to Quotes, this indicates the status of the various execution venues to which 

Active Trader Plus sends orders. Yellow indicates that one or more execution venues are 
unavailable, while red means that no orders can be currently placed. Hovering over this box 
will produce a list of execution venues with an “Up” or “Down” status for each.  
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6. Charts and Studies 
 
 
Working with Active Trader Plus Charts 
 
 
Active Trader Plus can display up to eight charts simultaneously, and each separate chart is 
numbered. New charts are added via either the Window > Chart menu, or the “New Chart” button 
on the Quick Launch tool bar. 
 

 
 
The basic elements of each chart include:  
 
• The Chart Symbol – the text field in the upper right. This works like the symbol field on each 

Stock Box.  A stock, index or option symbol can be typed in, or can be dragged and dropped 
from other modules.  

 
• The Chart Header – contains the company or index name in the title bar, and the Duration, 

Interval, and active studies settings in the upper left (see example above).  
 
• Main Chart Area – displays the chart data in candlestick, bar, or line format.  Studies are 

also displayed in this area – either below the chart price data, or overlaid with the pricing 
data.  

 
• Volume – below the main chart area the trading volume is displayed in bar or line format. To 

resize the volume area, hover over the horizontal bar which separates volume from the main 
chart area until a double-arrow icon appears.  Then click and drag the bar to the desired 
location.  

 
• Horizontal Scroll Bar – use the scroll bar at the bottom of the chart to move along the time 

axis.   
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• Stay to the Right Button - this button to the immediate right of the horizontal scroll bar 

toggles on and off and determines whether the chart automatically stays focused on the right 
edge (auto-scrolling as new data is displayed).  If toggled off the chart will stay focused 
wherever it is manually set along its horizontal axis.  

 
• After Hours Button – toggle this clock-icon button on to display chart activity which occurred 

outside of normal market hours.  
 
• Displaying Tick Details – click and hold the left mouse button in the 

main chart area to pop-up a details window (see the figure below). The 
details in this window correspond to the specific interval under the 
mouse pointer, and will change dynamically as the mouse is moved 
across the chart with the mouse button depressed. For each interval 
the display includes the Open, Close, High, and Low price data points, 
as well as the trading volume, time and date stamp, and the data 
values for any active studies within the interval.  

 
• Correcting a “Bad Tick” – although the Active Trader 

Plus servers filter for late or misleading tick data, 
occasionally some pricing data will be included in a chart 
that causes the chart to be skewed. When this occurs the 
user may correct the bad tick by double-clicking on the 
incorrect candlestick on the chart to pop-up the edit utility 
(see figure below). Enter the correct Open, Close, High, 
Low, or Volume value in the appropriate field, and click 
Save to refresh the chart and write the correction to the 
local disk. Active Trader Plus will retain the last 100 chart 
corrections on the local system so that refreshing a chart from the server does not cause the 
bad tick to reappear.  
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Basic Chart Settings 
 
 
Each Active Trader Plus chart can have its own unique settings and parameters. Right-click 
within a chart to configure the Interval, Duration, or to select the Chart Settings window that 
corresponds to the selected chart. As shown in the figure, switching between Intraday, Daily, and 
Weekly presentations is accomplished within the right-click menu. Additionally, the specific 
intervals in an intraday chart are selected from the intraday sub-menu, as are the number of days 
(1 to 5) that the minute chart will cover. When any of these menu choices are selected, the chart 
is instantly refreshed to the new settings. 
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Choose “Settings” from the right-click menu to display the Chart Settings dialog box. The first 
section in this window is labeled “Chart” and controls all of the basic chart characteristics except 
for studies’ parameters.  
 

Each element controls chart 
behavior as follows: 
 
• After Hours Colour – sets the 

background colour for chart data 
which occurs outside of normal 
market hours.  

 
• Background Colour – set the 

background colour for chart 
activity during standard market 
hours.  

 
• Chart Bar/Candlestick/Line – 

select the display type for price 
data within the main chart area. 
Expand any of these three 
selections (via the “+” button) to 
reveal further choices to control 
the display variables for each 
type of chart:  

 
• Width: sets the width of the 

interval in terms of horizontal 
pixels.  

 
• Colour: select a custom colour 

for a bar or line element. 
 
• “Use Up/Down Colours”: 

Active Trader Plus will paint the 
chart bars/lines in the standard 
Up and Down price colours 
(green and red by default), 
based on a comparison of the 
Open and Close prices for the 
interval, indicating whether the 
interval was up or down.  

 
• Days in Day Chart – the total number of days to display when Daily is selected for the chart 

interval via the right-click menu.  
 
• Display Cross Hairs – check this box so display persistent cross hairs whenever the mouse 

pointer hovers over the chart.  
 
• Grid/Scale Colour – select a custom colour for grid lines and scale label font.  
 
• Line Thickness – set the width of the line used to draw a line chart (has no effect in Bar or 

Candlestick charts).  
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• Link to Stock Box – by default, each chart is linked to the Stock Box of the corresponding 
number. This link allows the chart to update automatically when the symbol is changes in the 
corresponding stock box. To change the linkage enter the Stock Box number to which the 
chart should be linked – or enter a 0 (zero) if the chart should be independent of any 
linkages.  

 
• Overlay Colour: when an overlay symbol is added to the chart, its line and price scale will 

appear in this colour.  
 
• Overlay Symbol: type the symbol to be overlaid on the chart. In the figure above the 

NASDAQ Composite (^COMPX) is overlaid on the chart.  
 
• Support Line Default Colour: define the default colour for a horizontal line placed at a 

specific price point.  
 
• Support Line Thickness: specifies the thickness of a support line. 
 
• Time Scale Interval – this parameter determines how tight or wide the spacing is between 

the time scale values on the horizontal axis. A smaller number will condense the time periods 
into a smaller width, and a larger number will spread them out.  
Note: The Time Scale Interval may also be adjusted “on the fly” without using the settings 
dialog box. To change the horizontal scale of an active chart, place the mouse icon directly in 
the time scale area, and then click and drag to the left to condense the spacing, or click and 
drag to the right to expand the spacing. The Scale Interval number in the settings window will 
be set automatically. 

 
• Trend Line Default Colour: define the initial default colour for a user-defined trend line.  
 
• Trend Line Thickness: specifies the thickness of a user-defined trend line. 
 
• Volume – select whether to display volume as a Bar or Line graph, and choose the colours 

and widths as desired. Or select “None” to hide the volume section of the chart completely.  
 
• Weeks in Week Chart – the total number of weeks to display when Weekly is selected for 

the chart interval via the right-click menu. 
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Drawing Trend Lines and Support Lines 
 
 
Each Active Trader Plus chart can display up to six trend lines and three support lines 
simultaneously. Trend lines are user-drawn diagonal lines used to plot a price trend in order to 
more easily identify when a stock breaks through that specific trend. Support lines are horizontal 
lines which are typically used to define a support-resistance price range within which a stock is 
moving, also to help identify break-out events.  
 

 
 
Using Trend Lines:  
 
• Adding Trend Lines: Hold down on the [Shift] key and then click and drag with the left 

mouse button to draw the line.  The trend line will appear in the default colour specified within 
the Chart Settings.  

 
• Adjusting a Trend Line: position the mouse pointer over either end of the trend line until a 

4-arrow pointer appears. Then click and drag the end of the line as desired to change its 
angle and location.  

 
• Changing Colour: position the mouse pointer over either end of the trend line until a 4-arrow 

pointer appears. Right-click and select “Colour” from the pop-up menu.  Choose the desired 
colour from the custom colour box and click [OK].  

 
• Deleting Trend Lines: position the mouse pointer over either end of the trend line until a 4-

arrow pointer appears. Right-click and select “Delete” from the pop-up menu to delete the 
selected line. Or select “Delete All” from the pop-up menu to delete ALL of the trend lines on 
the selected chart (other charts will not be affected).  

 
 
Trend lines are treated separately within the Intraday, Daily, and Weekly charts. Trend lines 
placed on a Daily chart will NOT show up on the Weekly chart in the same Chart box. However, 
the maximum of six trend lines applies to the entire chart module – Intraday, Daily, and Weekly 
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combined. When the maximum of six trend lines is reached, adding a seventh line will 
automatically delete the first. 
 
Using Support Lines: 
 
• Adding Support Lines: Hold down on the [Control] key and then click the left mouse button 

to insert the horizontal line.  The support line will appear in the default colour specified within 
the Chart Settings.  

 
• Adjusting a Support Line: position the mouse pointer over the support line until a 2-arrow 

pointer appears. Then click and drag the line up or down as desired to change its location.  
 
• Changing Colour: position the mouse pointer over the support line until a 2-arrow pointer 

appears. Right-click and select “Colour” from the pop-up menu.  Choose the desired colour 
from the custom colour box and click [OK].  

 
• Deleting Support Lines: position the mouse pointer over the support line until a 2-arrow 

pointer appears. Right-click and select “Delete” from the pop-up menu to delete the selected 
line.  Or select “Delete All” from the pop-up menu to delete ALL of the support lines on the 
selected chart (other charts will not be affected).  

 
Support lines placed within a chart box are displayed on all three of the chart types within that 
box. Support lines placed on a Daily chart WILL show up on the Weekly and Intraday chart in the 
same Chart box. When the maximum of three support lines is reached, adding a fourth support 
line will automatically delete the first.    
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Studies – Average Directional Index (ADX) 
 
 
To activate the ADX study:  
 
• Check the box next to the study title.  
 
• Expand the study (click the “+”) to set the specific parameters. 

 
• Choose the colours for the three lines (ADX, DMI-, and DMI+). 

 
• Choose the number of intervals for ADX Period and DMI Period. 

 
• Select the “Overlay” option to display the study lines within the area as the pricing data, or 

leave this clear to display the study below the chart with a separate vertical scale. 
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Studies - Bollinger Band (BB) 
 
 
To activate the Bollinger Band study:  
 
• Check the box next to the study title.  
 
• Expand the study (click the “+”) to set the specific parameters.  
 
• Choose the colours for the three lines (BB Avg, BB-, and BB+)  
 
• Choose the number of intervals for the BB Period and the number of Standard Deviations.  
 
• The Bollinger Band is always displayed as an overlay.  
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Studies – Moving Average Convergence Divergence (MACD) 
 
 
To activate the MACD study: 
 
• Check the box next to the study title. 
 
• Expand the study (click the “+”) to set the specific parameters. 
 
• Choose the colours for the two lines (MACD, and Trigger). 
 
• Choose the number of intervals for Period 1, Period 2, and Trigger Period. 
 
• Select the “Overlay” option to display the study lines within the area as the pricing data, or 

leave this clear to display the study below the chart with a separate vertical scale. 
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Studies - Momentum (MOM) 
 
 
To activate the Momentum Study: 
 
• Check the box next to the study title.  
 
• Expand the study (click the “+”) to set the specific parameters.  
 
• Choose the colour for the line.  
 
• Choose the number of intervals for the Momentum Period.  
 
• Select the “Overlay” option to display the study lines within the area as the pricing data, or 

leave this clear to display the study below the chart with a separate vertical scale.  
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Studies - Moving Averages (MA) 
 
 
To activate the Moving Average studies: 
 
• Check the box next to the study titles.  
 
• Expand the studies (click the “+”) to set the specific parameters.  
 
• Choose the colours for the lines.  
 
• Choose the number of intervals for the MA Period.  
 
• Moving Averages are always overlaid, so the “Overlay” option is not available.  
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Studies - Rate of Change (ROC) 
 
 
To activate the ROC study: 
 
• Check the box next to the study title.  
 
• Expand the study (click the “+”) to set the specific parameters.  
 
• Choose the colours for the ROC line.  
 
• Choose the number of intervals for the ROC Period.  
 
• Select the “Overlay” option to display the study lines within the area as the pricing data, or 

leave this clear to display the study below the chart with a separate vertical scale.  
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Studies - Relative Strength (RSI) 
 
 
To activate the RSI studies:  
 
• Check the box next to the study titles.  
 
• Expand the studies (click the “+”) to set the specific parameters.  
 
• Choose the colours for the each RSI line.  
 
• Choose the number of intervals for the RSI Period(s).  
 
• Select the “Overlay” option to display the study lines within the area as the pricing data, or 

leave this clear to display the study below the chart with a separate vertical scale.  
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Studies – Stochastics 
 
 
To activate the Stochastics study:  
 
• Check the box next to the study title.  
 
• Expand the study (click the “+”) to set the specific parameters.  
 
• Choose the colours for the three lines (%D Fast, %D Slow, and %K)  
 
• Choose the number of intervals for the %D Fast Period, %D Slow Period, %K Period, and 

%K Slow Period.  
 
• Select the “Overlay” option to display the study lines within the area as the pricing data, or 

leave this clear to display the study below the chart with a separate vertical scale.  
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Studies – Triple Exponential Smoothing Oscillator (TRIX) 
 
 
To activate the TRIX study:  
 
• Check the box next to the study title.  
 
• Expand the study (click the “+”) to set the specific parameters.  
 
• Choose the colours for the two lines (TRIX, and Trigger)  
 
• Choose the number of intervals for the TRIX Period and Trigger Period.  
 
• Select the “Overlay” option to display the study lines within the area as the pricing data, or 

leave this clear to display the study below the chart with a separate vertical scale.  
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Studies – True Strength Index (TSI) 
 
 
To activate the True Strength Indicator (TSI) study:  
 
• Check the box next to the study title.  
 
• Expand the study (click the “+”) to set the specific parameters.  
 
• Choose the colour for the TSI line  
 
• Choose the number of intervals for MA Period 1, MA Period 2, and the Momentum Period.  
 
• Select the “Overlay” option to display the study lines within the area as the pricing data, or 

leave this clear to display the study below the chart with a separate vertical scale.  
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7. Market Tools and Utilities 
 
 
Market View 
 
 
The Active Trader Plus Market View module provides streaming Level I data on hundreds of 
user-defined symbols. It allows for the symbols to be organized into manageable tabs so that 
market sectors or favourite traded symbols can be monitored together at a glance. 
 

 
 
 
• Adding Symbols: to add symbols right-click in the main body of the desired tab and choose 

“Add”. Type a valid symbol into the highlighted entry field, and press [ENTER] to move to the 
next line for entering multiple symbols.  

 
• Deleting Symbols: right-click on the desired symbol and click “Delete”. 
 
• Alerts: alerts can be set on symbols in the Market View as follows:  
 

• Right-click on the symbol to be monitored and select “Alert”.  
• In the Alert Setup box check any combination of the twenty different 

available alerts.  
• Click OK to save the settings and note that a red alert arrow will 

appear next to the symbol on which the alert has been activated.  
• When the monitored event occurs (i.e. the symbol makes a new high 

or new low or is crossed/locked) a detailed alert box will pop-up and a 
tone will sound. The symbol which generated the alert will flash red in 
the Market View window.  

• To remove and disable the alert, right-click on the symbol and select 
“Delete Alert”.  

• To reset the alert after it is triggered, so that the symbol stops 
flashing and the next event can be detected, right-click on the symbol 
and choose “Reset Alert”. 
NOTE:  Alerts will function for any selected symbol, whether the tab 
that contains the symbol is currently visible or not. 

 
• Moving Symbols – Simply drag and drop the symbol to the desired 

location.  The “move up” and “move down” commands can be used as an 
alternative way to reorder symbols. 
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• News – select news to display the News window and view only stories pertaining to the 

selected symbol or choose headlines to view up to the minutes stories for all stocks. 
 
• New List: adds a new tab to the module and asks the user to enter the tab name.  
 
• Columns: the Market View right-click menu includes both a “Columns” choices and a “Smart 

Width” feature, which function exactly as in all other modules. Use “Columns” to determine 
which columns are visible and in what order, and use “Smart Width” to space the visible 
columns efficiently. 

 
• Quick Launch Buttons – Use the Quick Launch buttons to quickly access a Chart, 

Stock Box (Level II), News Box, or Option Box (option chain) for the chosen symbol in 
one click. 

 
 
 
 
 
 
 
 
• Tabs: Right-click in the header area of the Market View module to manage the user-defined 

tabs.  
  

• New List – adds a new tab to the 
module and asks the user to enter the 
tab name.  

 
• Rename List – allows the user to enter 

a new name for the selected tab.  
 

• Delete List – removes the specific tab 
and all of its contents.  

 
 
Note:  
 

• The maximum number of tabs is 10. 
• The maximum symbols per tab is 45 (for a total of 450) 
• The maximum number of alerts is 15 
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Symbol Lookup 
 
 
The Active Trader Plus Symbol Lookup allows a user to find a specific equity or index symbol by 
name. It also allows an option contract symbol to be entered, and returns the corresponding root 
equity symbol. 
 

 
 
As shown in the figure above, when the “Company Name” radio button is selected any part of the 
company name may be entered in the “Name” field, and a specific exchange may be selected 
from the “Exchange” drop-down (or it may be set to “Any”). The search will return the top 50 
symbols whose company names contain the search string – use more of the company name or a 
specific exchange to further refine the search.  
 
Once the desired symbol is located it can be dragged and dropped into any Stock Box, Chart, or 
Market View tab.  
 

 
 
If a user knows a specific option symbol – either a Call or a Put – they may use the Symbol 
Lookup to find the underlying, or “root”, equity symbol. When the “Option Root Lookup” radio 
button is selected, a specific options contract is entered in the “Name” field and Active Trader 
Plus returns the corresponding root symbol (as shown above). The “Exchange” drop-down is 
disabled as it is not relevant when using this function. The root symbol can then be dragged and 
dropped into an Option Box in order to display the entire option chain.   
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Index View 
 
 
The Index View module offers the same basic functionality as the Market View, but is designed 
so that the user may track indices. 
 

 
 
The Index View supports up to eight simultaneous symbols, but does not offer a tabbed interface 
like the Market View. Symbols are entered and deleted just as they are in Market View, and the 
column manipulation is identical as well. Alerts can also be set on the symbols in this module, 
and are managed through the same interface.  
 
 
The right-click menu available in the Index View offers six Index 
Shortcuts. Select “Add Dow” to insert the Dow Jones Industrials symbol, 
“Add Nasdaq” to insert the NASDAQ Composite Index, etc. Add any 
other desired symbols through the normal “Add” selection. 
 
 
The Index View will support valid Equity symbols as well as Index 
instruments.  
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Top Performer List 
 
The Top Performer List displays the Top Ten 
Most Actives, Percent Gainers, Percent 
Losers, Dollar Gainers, or Dollar Losers for 
each major North American equity and option 
exchange (TSX, AMEX, NASDAQ, NYSE, TSX-
Venture, CBOE, and Montreal) as well as the Dow 
30 and S&P500 benchmark indices.  Simply select 
the type of list and the exchange or index from the 
dropdown menus.  You can customize the 
columns to display the data you are interested in 
by right-clicking and selecting “Columns”. 
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News Window 
 
 
You can use the News window to view a list of real-time news and stories related to the market 
as they happen. You can also select whether to monitor all headlines as they are published or 
you can type a symbol into the Search tab to display stories for specific securities. 
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Baskets 
 
 
The Baskets module manages the creation of multi-symbol basket orders. This advanced order 
type allows the user to simultaneously place orders for multiple symbols, using a consistent ratio 
of share sizes between the different symbols. 
 
The header area (see figure below) shows the active account number for which any basket 
orders will be sent, and a “Refresh” button to the right of the account drop-down. The Refresh 
button updates the Level I snap quote data for each of the symbols in the active basket window.  
 
The main window of the Baskets module is tabbed, so that multiple user-defined baskets can be 
created and managed simultaneously. Each basket has its own named tab, and contains its own 
selection of stocks and share sizes. The individual tabs (each of which constitutes a basket) are 
managed by right-clicking in the header area and selecting “New Basket”, “Delete Basket”, or 
“Rename Basket”.  
 

 
 
The contents of each Basket are created by entering the symbols to be included, and the default 
share size for each symbol.  Use the right-click “Add” option to enter symbols and quantities.  The 
default share size is entered in the “Size” column (see the figure above).  
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Once the symbols and default sizes are entered, the makeup of specific basket orders is 
controlled via the Basket Order Ticket at the bottom of the module. The entire basket is scaled up 
or down to a specific dollar amount by manipulating the various pricing or percentage fields in the 
order ticket:  
 
• Percentage (see figure below):  As the percentage is increased or decreased, the “Shares” 

column will change accordingly, as will the dollar amount totals in the “Amt” column and in the 
total order price fields on the Buy and Sell sides.  If “Even Lots” is checked, the share sizes 
will only move in increments of 100, otherwise they will scale in single share increments.  

 
• Total Amounts: The user may enter a total desired transaction price on either the Buy side 

or the Sell side of the order ticket. The share sizes will then be automatically adjusted to 
maintain their relative ratio while creating a total basket which most closely matches the 
desired price. If “Even Lots” is checked, the share sizes will be forced to increments of 100, 
otherwise they will scale in single share increments.  

 
• Limit Delta Price: This field sets the difference between the current Best Bid or Ask and the 

limit price that will be sent with each order.  As this field is adjusted (by typing in an amount or 
using the arrow keys) the total transaction dollar amounts will adjust as well, while the share 
size remains static.  
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Basket order scaled by the percentage (%) field 
 

 
 
Basket order with a Limit Delta set 
 
Once all fields are set, clicking any of the order buttons will send a single order for each symbol in 
the basket.  The order type is determined by the drop-down in the ticket, and the destinations will 
be the defaults based on the security type and order type matrix. Orders generated by the Basket 
interface can be managed via the open orders section of the Account Box like all other orders.  
Cancellation can be done individually by order or with the “Cancel All’ button in the Account Box.  
 
As with all Active Trader Plus order modules, the Basket interface send orders to the markets the 
instant any order button is pressed. Simultaneous orders for thousands of shares can be sent 
accidentally if a user does not exercise caution. Hot Key combinations do not function in the 
Basket module.   
 


